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1)

Introduction

1.1
Using this manual
This user’s manual aims to make it easier to use the East Usambara Biodiversity Database by
providing brief explanations of the key concepts and tools that have been used to construct the
database. The manual can be used by first-time users and by those already familiar with the
database. For first-time users there is also an orientation guide available from the East Usambara
Conservation Area Management Programme (EUCAMP). If your aim is to extract data for
research or management purposes without having to understand all the intricacies of the database
then the Orientation Programme is probably the best place to begin.
The manual begins by looking at the three most commonly used objects in a database: tables,
forms and queries. It then considers issues relating to the management of the database. Finally,
the appendix gives a breakdown of the contents of the database’s tables.
1.2
Background to the database
1.2.i Microsoft Access
The programme used by the database is Microsoft Access. This is a powerful database
programme that allows you to manipulate data in many different ways. Doctoral theses have
been written on how to use Access. This manual is limited to the information most pertinent to
running and managing the East Usambara Biodiversity Database. If you want to go further there
are various books available within EUCAMP that describe in more detail how Access functions.
Access also provides a help facility (Section 1.5).
1.2.ii The East Usambara Biodiversity Surveys
The East Usambara Biodiversity Database (EUBD) stores the data collected by the East
Usambara Biodiversity Surveys. Since 1994, Frontier-Tanzania has been surveying biodiversity
in the Forest Reserves of the East Usambara Mountains. By March 2000, 12 Forest Reserves and
Amani Nature Reserve had been surveyed. The database holds the data from all components of
these surveys including vegetation, mammals, reptiles, amphibians, butterflies, molluscs,
millipedes and disturbance from human activities.
The East Usambara Biodiversity Surveys Methods Manual describes the systematic methods used
by the surveys. For those not familiar with the surveys, the methods manual is a useful
complement to this manual.
1.2.iii Forest reserve codes
All data are geographically referenced so that they can be traced back to the sample plot and
Forest Reserve in which they were collected. The names of the forest reserves are coded. The
codes for the forest reserves are:
FOREST RESERVE
CODE
AN
BA
KA
KW
LO
MA
MG

FOREST RESERVE
Amani Nature Reserve
Bamba Ridge Forest Reserve
Kambai Forest Reserve
Kwamgumi Forest Reserve
Longuza Forest Reserve
Kwamarimba Forest Reserve
Magorotto Forest Reserve

Table 1 Forest Reserve codes
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FOREST RESERVE
CODE
MN
MP
MT
MU
SG
SM

FOREST RESERVE
Manga Forest Reserve
Mpanga Forest Reserve
Mtai Forest Reserve
Mlungui Forest Reserve
Segoma Forest Reserve
Semdoe Forest Reserve
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A detailed description of the reserves including their codes is in the table c:/biodiv/biodiv/Forest
Reserve Descriptions.
Forest Reserve maps showing the location of the sample plots are available in the relevant
biodiversity survey report available from EUCAMP.
1.3
Database basics
The EUBD is a Microsoft Access database. It is a relational database meaning that each record in
the database contains information related to a single subject and only that subject. Access is a
Windows programme similar to Excel or Word.
1.3.i Database objects
There are three database ‘objects’ that are particularly useful for entering and extracting data:
a) Tables
Tables store the data and are the most basic components of any Access database.
b) Queries
The database contains thousands of records. Queries enable you to extract just the information
that you need.
c) Forms
Forms present the data in a more intuitive way than the tables. The forms on the database are the
same design as those used by the biodiversity surveys in the field. They are particularly useful
for data entry.
1.4
Moving data to other Office programmes
There are times when you may want to view or manipulate information from the database using
other Office programmes. Access provides a facility whereby you can move data directly to
Excel or Word.
You can either move all data from a table, filter or query or you can move only a subset of the
data.
a) To move the results of a query (Section 3) to Excel. Go to the datasheet view of the query
results.
b) In the tools menu, select ‘Analyse it with MS Excel’ in the ‘Office Links’ sub-menu.
c) Access automatically sends the data to a new Excel file.
If you only wish to send a subset of a query or table simply select the field values that you want
to transfer and then send it to excel using the Office Links sub-menu described above. Access
will automatically send the selected area only.
If you wish to send the data to a new word file, select the option ‘publish it with MS Word’.
Alternatively you can insert it as a table in an existing Word file by using the Merge It with MS
Word.
NB
If you try to move all the data from one of the larger tables e.g. trees >10 cm dbh you may
run into difficulties as neither word nor excel are designed to cope with such a large amount of
data.
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1.5
Using the Office assistant
If you get stuck or want to find out more information about the database help is at hand. Click on
the ? button at the right of the menu bar. The Office assistant appears with options relating to the
tasks you recently completed. If none of the options is helpful, you can type a question in the
Search box and click the Search button to have the Office Assistant look up matching topics.
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2)

Tables

2.1
Opening the database
2.1.i A step by step guide to opening the database
Follow these steps to open the East Usambara Biodiversity Database:
a) From the Windows desktop, go to the start menu. Click once and drag the mouse up to
Programmes.
b) In programmes, double click on Microsoft Access (it has a key icon).
c) Access opens and asks whether you want to open an existing database.
d) Select ‘c:/biodiv/biodiv’ from the list of databases in the dialogue box. If biodiv/biodiv is
not listed, see 2.1.ii.
e) You are now presented with the green start up form that asks whether you want to ‘open a
data entry form’ or ‘open a data output form’.
f) If either of these options is what you want then click on the relevant button. If you wish
to access the data in table format then go to the list of menus close to the top of the screen
and click on the ‘Window’ menu.
g) At the bottom of this ‘Window’ menu it lists all the items that are currently open. At the
moment there should be a choice between:
a. Biodiv: database
b. EUCFP START-UP FORM: form
h) Select ‘Biodiv: database’. The window lists all the tables that constitute the biodiv
database. This is known as the database window. See Section 2.2 to open the table of
your choice.
2.1.ii Alternative ways of opening the database
There are various other ways of opening the database. The quickest way is to double-click on the
tree icon labelled Biodiversity Database in the desktop window. Alternatively once you are in
Access you can go to Open Database in the file menu and, select c:/biodiv/biodiv and click Open.
2.1.iii The ‘biodiv’ and ‘biodata’ databases
The EUBD consists of two linked databases called ‘biodiv’ and ‘biodata’. The contents of these
two databases are described in detail in the Appendix. In brief however the database is designed
so that a user can access all tables in both databases through the biodiv database. Biodiv should
be the database with which you work. Changes made in one database are automatically made in
the other.
2.2
Introducing tables
The biodiversity information is stored in various tables. Each table contains related information
about e.g. reptiles, amphibians, mammals etc. With the tables tab selected in the database
window you can open any table either by double clicking on it or by selecting it and clicking on
open.
For example, let’s have a look at the amphibians table:
a) In the database window, select AMPHIBIANS from the list of tables and click the ‘Open’
button to the right of the dialogue box. Access now displays all amphibian records.
Tables consist of items of information arranged in columns, called fields, which have headings,
called field names, which describe the type of information in each column. In this case FR Code,
Plot id, KMH number etc.
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Each item of information is a field value, and each row of items is a record. Each record contains
all the information on, in this case, a particular specimen.
2.3
Moving around tables
You can move around the table using a variety of different tools:
2.3.i Scrolling
Access, like most Windows programmes, automatically adds scroll bars along the bottom and
right sides of the window. You can click the scroll arrows to move to the left or right one field at
a time or up and down one record at a time. Within the scroll bar, click on either side of the
scroll box to move one windowful of records at a time.
2.3.ii Record indicator
As well as using the scroll bars, you can click the buttons on either side of the record indicator at
the bottom left of the window to move among records. The Previous Record and Next Record
buttons, the left and right arrow heads, move you through the table one record at a time, and the
First Record and Last Record buttons, the arrow heads pointing to a solid line, move you to the
first and last record in the table. The New Record button, the arrowhead pointing to an asterisk,
moves you to the first field of the empty record after the last record.
2.3.iii The mouse
You can move the insertion point to a specific field value by clicking the desired location. To
select a field value, click its left border (the pointer will be shaped like a fat cross).
2.3.iv The keyboard
Using the keyboard is often the fastest way to move around a table. A list of the keys you can use
is listed below:
Use this key….
Tab
Right and left arrows

To move….
Horizontally one field at a time
When a field is highlighted, horizontally one field at a
time; otherwise, moves the insertion point one character
at a time.
Vertically one field at a time
To the start of the current field value
To the end of the current field value
To the start of the first record of the current table
To the end of the last record of the current table
Down one windowful of records
Up one windowful of records
To the right one windowful of fields
To the left one windowful of fields

Up and Down Arrows
Home
End
Ctrl+Home
Ctrl+End
Page Down
Page up
Ctrl+Page Down
Ctrl+Page Up
Table 2 Keys used to move around in a table

2.4
Entering data in a table
In the biodiversity database you can enter and edit records either directly in the table or in a form.
The easiest way to enter data is on the forms however there may be times when you want to enter
data directly into the tables.
If for example you wanted to enter a record of a tree frog, Leptopelis uluguruensis, collected on
13.3.98 by Raymond Kilenga from plot 1 in Amani you would follow the following steps:
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a) With the amphibians table open, choose *New Record from the Insert menu. Access
takes you to a blank record at the end of the table.
b) In the FR Code field, type ‘AN’.
c) Then enter these field values for this record.
FR Code

Plot Id

KMH
Collector Date:
Date:
Date:
Taxon
Genus
Species
No.*
Day
month
year
Id
AN
1
2000
RK
13
3
1998
FROG
Leptopelis uluguruensis
*KMH No. refers to the unique identification number allocated to all vertebrate specimens. This number is allocated
in the field and is marked on the record sheets.

We’ll leave the other fields blank for now.
d) Put the insertion mark down into the next record. Your record is automatically saved by
Access. Remember to delete these test entries (2.5.ii).
2.5
Editing records
2.5.i Editing field values
If you make a mistake while entering a field value, you can use the Backspace key to delete the
error and then retype the value. If you discover a mistake later, you can click an insertion point
in the offending field and use normal editing techniques. You can also use one or two editing
tricks as you enter values.
If two consecutive records have the same field values:
a) If necessary, click the New Record button on the toolbar to move to the empty record at
the end of the table, and then press Enter to move to the First Name field.
b) Press Ctrl+’ (single quotation mark). Access duplicates the value from the same field of
the preceding record in the active field. Press enter to move to the next field.
2.5.ii Deleting records
To delete a record, you simply select the record and click the Delete Record button (the red ‘x’)
on the tool bar or press the Delete key.
For example:
a) To the left of each record in the table window there are shaded boxes. Drag the mouse
over the shaded box to the left of the record that you want to delete. The cursor changes
shape. When it appears as a right-pointing black arrow it allows you to select the entire
record. Select the record to be deleted.
b) To delete the selected record you can either press delete on the keyboard or you can click
the delete button (a red x) on the tool bar.
c) A dialogue box appears warning you that this action cannot be undone. If you are sure
you want to delete the record, click yes. Be careful when deleting records. If you make a
mistake and delete the wrong record, you can’t restore the record by clicking an Undo
button or choosing Undo from the Edit menu after you’ve confirmed the deletion.
If you want to delete multiple adjacent records, select the records to be deleted by dragging the
mouse over their record selector boxes (the shaded boxes to the left of the first field) and then
press delete.
2.5.iii Find and replace tool
If you want to make the same change in more than one record, Access provides a way to do this
quickly and easily. For example imagine that you have found that the tree genus Scorodophloeus
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has been spelled as Scorodophleus in numerous records in the table ‘trees >10 cm dbh; rather
than changing each record individually you can change all misspelled entries at once.
a) Select any cell in the column whose values you want to change in this case the genus field
(select the cell in the first row if you want to start at the beginning of the table).
b) Choose the Replace command from the Edit menu or press Ctrl-H to see the replace data
dialogue box.
c) Type the value which you wish to replace i.e. Scorodophleus (the incorrect spelling) in the
Find What text box and then type Scorodophloeus (the correct spelling) in the Replace
With text box.
d) Click the Find Next button to search for the next occurrence of the text you’ve typed in
the Find What text box.
e) Click the Replace button to change data selectively or click the Replace All button to
change all the entries that match the Find What text.
2.6
Sorting and filtering records
2.6.i Sorting records
The database contains many records. When working with such a large table, you may want to
sort the records on a particular field. For example you may want the records to be listed by KMH
No or by Forest Reserve. Here’s how to sort the records of the amphibians table by KMH No.
a) Click anywhere in the KMH No column and then click the sort ascending button (AZ↓)
on the toolbar to sort starting with the lowest number. Click the sort descending button
(ZA↓) to sort starting with the highest number. All records are now sorted in order of
KMH No. Unlike Excel Access automatically treats everything in a row as a single
record. Sorting records does not change the data, only the order in which it is displayed.
2.6.ii Auto filters
You can temporarily focus on a subset of records that have something in common by using
filters. For example you might only want to look at amphibian records from Kwamgumi. To do
so follow these steps:
a) In the FR Code field of the AMPHIBIANS table double click on any field value listed as
KW (Kwamgumi). Then click the filter by Selection button on the toolbar (a symbol of a
funnel with a lightening flash beside it). Access displays only those specimens from
Kwamgumi.
b) Click the Remove Filter button (a symbol of a funnel) to redisplay all the records in the
table
You can also add a filter to a filter. For example, if you only wanted Bufo records from
Kwamgumi you could add another filter to the filter described above.
a) In the datasheet that was returned by running the KW filter within the amphibians table,
go to the genus field. Here find a field value listed as Bufo.
b) Double click in the Bufo field value and again click on the filter by selection button.
Access will return all Bufo records collected in Kwamgumi.
2.6.iii Filter by form
If you wanted to select records that meet any of several criteria you could use the filter by form
option that enables you to specify multiple criteria in any field. For example if you wanted to
view the amphibian records from Kwamgumi, Mtai and Manga, you could use the filter by form
tool.
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The Filter by Form button is beside the filter by selection button and shows a funnel with a form
beside it.
When you click the Filter By Form button on the Table Datasheet toolbar, Access shows you a
Filter By Form example that looks like your datasheet but contains no data. If you have no
filtering criteria previously defined, Access shows you the Look For tab and one Or tab at the
bottom of the window. Move to each column in which you want to define criteria and either
select a value from the drop-down list or enter criteria. In this case:
a) Type KW in the FR Code field.
b) Click the Or tab at the bottom of the Filter by Form window.
c) Type in MT and click the Or tab again.
d) Type in MN (Manga).
e) Click on the apply filter button.
Access returns all amphibian records from Kwamgumi, Mtai and Manga. Instead of using the Or
tab you could also type ‘or’ in yourself e.g. MN or KW or MT.
To return to the main table click the remove filter button on the tool bar.
2.7
Changing the table layout
2.7.i Sizing windows
To see the information in a table, you may have to enlarge the Table window or adjust the sizes
of the fields. Perhaps you’ve noticed that as you move your mouse around the screen, the pointer
sometimes changes shape. On the frame of a window, on the gridlines between the field names,
and on the dividing lines between the row selectors, the pointer changes to various kinds of
double-headed arrows. While the pointer has this shape, you can resize the table window or the
fields.
To resize the window, simply point to its frame, and when the pointer changes to a double-headed
arrow, hold down the left mouse button and drag the frame to decrease or increase the window’s
size.
2.7.ii Sizing fields
Resizing the fields is equally simple, as you’ll see as you follow these steps:
a) In any table, move the pointer to the gridline to the right of the field whose size you wish
to change.
b) When the pointer changes to a double-headed arrow, hold down the left mouse button and
drag to the right. When the line attached to the pointer is about where you want the
field’s border to be, release the mouse button.
c) Point to the dividing line between the first and second row selectors and drag downward
to increase the heights of all the records in all the fields. (You can’t adjust the height of
only one record).
Another way to change the widths of fields is to use the column width option in the format menu.
This option allows you to define exactly the width of one or more fields. For example if you
wanted to define the width of the colour note fields in the AMPHIBIANS table, follow these
steps:
a) Scroll the table until the Colour note fields are visible. Move the pointer to the first
colour note field name, and when the pointer changes to a downward-pointing arrow,
click to select that field in all records. Then move the pointer to the next Colour note field
name, hold down the Shift key, and click to add the other Colour note fields.
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a) Choose Column Width from the Format menu to display the dialogue box.
b) Type 30 as the Column Width and press Enter to change the widths of all four fields at the
same time.
These are temporary cosmetic changes to the layout of the table and do not affect the underlying
data. You can make a field so narrow that you can no longer read all the data. This does not
affect the data itself only the way that it appears on the screen.
2.7.iii Moving fields
You can change the field order by selecting a column and dragging it to a new position. For
example in the amphibians table, if you want to look up the identification of a particular
specimen, it might be useful to see the KMH No field next to the Genus field. Follow these steps
to move the KMH No field:
a) Click the KMH No field name once to select the entire column. The field name is the box
at the top of the column in which the column title is written.
b) When the KMH No field is selected, point to the KMH No field name, hold down the left
mouse button, and drag the field to the right. As you move the field, Access highlights
the dividing lines between columns to indicate the new position of the KMH No field.
c) When the dividing line to the left of the Genus field is highlighted, release the mouse
button. The KMH No field is shown in its new position.
2.8
Saving changes in tables
2.8.i Saving changes to field values
When editing or inputting data, Access automatically saves the changes that you have made as
soon as you move to another row. Once you leave a row you cannot undo any changes.
However before moving to a new row, you can press Esc once to undo a change to the current
value or press Esc twice to undo all changes in the row.
2.8.ii Saving changes to the table layout
If you make changes to the layout of the table for example changing the width or order of the
columns then you need to save these using the save command in the file menu. If you try to close
a table where you have made changes to the layout of the table Access will prompt you to save
your changes.
2.9
Looking at table design
When the tables were designed the structure of each field was carefully defined. There may be
times when you need to understand how the fields in a table have been defined. This is
particularly useful if you run into any difficulties with data entry. In order to see the structure of
a table you need to access the design view of the table.
To do this you open the table as normal and then use the view toggle button to switch to the
design view of the table. For example to view the reptile table in design view, follow these steps:
a) Open the REPTILES table.
b) To the right of the tool bar there should be a button with a green triangle, a ruler and a
pencil. This is the view toggle button that takes you between the design and datasheet
views. Click on this button.
c) A warning box will appear stating that REPTILES is a ‘linked table with some properties
that can’t be modified’. Click yes to proceed.
d) Your table is now open in design view. If you want to move back to the datasheet view
you simply click on the view toggle button again. Alternatively in the view menu you can
select datasheet view.
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In design view, the upper part of the Table window displays columns in which the field names,
the data type and a description of each field are listed. In the lower left area of the Table window,
the properties of each field are defined. In the lower right area of the Table window is a box in
which Access displays information about fields or properties. These properties can be changed
and there may be times when you find this necessary. More information on field properties is
available in the Access manual or by using the Access help facility.
Only the database managers should make changes to the design of the tables. Before making
such changes, always make a back up of the database. You should be careful when changing
field properties as if you set new properties for which the existing data is not valid, Access will
delete the data.
2.10 Dates in tables
Access treats dates differently to other numbers. In the design view of a table you can select a
‘date / time’ data type for a field that contains dates. Alternatively dates can be broken up into
their component parts i.e. the day, month and year. Each component can be a different field and
the values can be treated as normal numbers. In most cases in the biodiversity database, dates
have been broken up into their component parts i.e. there is a field for the day, month and year.
In these cases the fields are treated as normal numeric fields.
If you select date / time in the data type field you will see that in the format row of the field
properties you are offered a variety of different dates. The format of these dates will depend on
your computer’s regional settings.
The dates used in the EUBD follow English (United
Kingdom) regional settings. If you use the database on a computer with different regional
settings e.g. English (United States) you will not be able to enter dates although existing dates
will not be changed.
To change your regional settings go to the Settings from the Windows tool bar and select Control
Panel. In Control Panel select the globe icon labelled Regional Settings and select English
(United Kingdom). Note: this will change the regional settings for all documents. If you have
any financial databases it may also change the default currency.
In most of the forms the day, month and year fields are separate. These fields are formatted as
Numbers (Integers) subject to validation rules. For example the year value on all forms must be
between 1990 and 2100. If necessary these validation rules can be changed by going into the
design view of the table in question.
2.11 Relationships between tables
Some of the tables in the database are ‘related’. This means that tables are automatically linked
in queries, forms and reports. You can view the relationships that have been defined in the
database.
a) Close all tables.
b) Click on the Relationships command from the Tools menu. The relationships button has
an icon of three datasheets joined by two black lines.
You will now see all the tables that are joined in a relationship. For example the two tables
‘BUTTERFLIES’ and ‘Butterflies table’ are related. In order for tables to be joined they need to
have at least one field in common. In the case of the butterflies they have the FR Code and Plot
Id fields in common and these fields have been used to link the tables.
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2.12 Linked tables
In the database window you may notice that some tables appear with a black arrow to the left of
them. This arrow denotes that the table is a linked table i.e. it is located in another database, in
this case ‘biodata’. The link enables you to view and change the data while you are in biodiv
however you can only make restricted changes to the design of the table unless you go into its
‘home’ database.
You can delete the link that allows access to a table from another database by selecting a table in
the database winsow and clicking on delete. This does not delete the table, only the link that
enabled you to access the table in the biodiv database. You can retrieve a table from another
database by selecting the ‘Link Tables’ option from ‘Get External Data’ in the File menu.
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3)

Forms

3.1
Introducing forms
Forms are most commonly used for viewing and editing data because they are more intuitive than
the table datasheets. The biodiversity database forms are the same as those used to collect the
data in the field making it easy to transfer the data from the field and onto the database. You can
also print a form if you want a hard copy of a record.
3.2
Viewing data using forms
If you are interested in seeing the data organised by record e.g. by specimen or vegetation plot
rather than by field e.g. by FR Code or Genus, then the form view is the most appropriate
viewing option. You can view the data in a form as follows:
a) Start by opening up the biodiversity database c:/biodiv/biodiv*. If you need a reminder
of how to do that, look back to Section 2.2.
b) A green screen appears with three selectable buttons: ‘ Close database’, ‘Open a data
entry form’ or ‘Open a data output form’. Select ‘Open a data output form’.
c) You are now presented with a choice of the different forms available. If for example you
were interested in the amphibian data you would click on ‘Open Amphibians’.
*If you are already in the database window go to the Window menu and select ‘EUCFP start-up form: form’ from the
list of windows currently open. Now return to b).

A completed form now opens. You can use the scroll bars to move around the form. For each
field the form displays a control where you will enter information. Each control is accompanied
by a box called a label that contains the field’s name e.g. F.R. Code, Plot Id, KMH No. etc.
In the top section of the form there is information on the locality, identity and collection of the
specimen. In the second section of the form are the habitat details and in the final section the
biometrics and colour of the specimen are recorded.
Notice that for some entries such as KMH number, FR code and collector the data has been typed
in. In other cases such as for the genus and species there are drop down lists available and in
other cases such as for the habitat details, a box can be ticked beside the relevant option.
You can move between forms either by clicking on the ‘Next Record’ or ‘Previous Record’
buttons at the top of the form, or you can use the record indicator at the bottom of the Access
window.
3.3
Entering data using forms
Forms provide the most straightforward way of entering data. Once you have opened a blank
data entry form you can move between fields by using the tab button or by moving the insertion
point with the mouse. Below is an example of how to enter data to a form, in this case for a tree
frog from Semdoe.
a) At the start-up window click on Open a data entry form.
a) Click Open Amphibians. You are now presented with a blank form.
b) In the control beside F.R. Code type ‘SM’. Press tab or enter to take you to the Plot Id
control.
c) Fill in the top section as Plot Id: 10; KMH: 20001; Collector: RK; Day: 6; Month: 11;
Year: 1997; Taxon Id: Frog.
d) In the Genus control you will see that there is a black arrow in a grey square to the right of
the control box. Click on this. A list of all the genera known from the East Usambaras
appears. This is a look up table and is designed to minimise spelling errors in the
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e)
f)
g)
h)
i)

database. The look-up table has its own scroll bar. Scroll down to Leptopelis, select it
and press enter.
In the species control there is another look up table available. This time listing all the
species of Leptopelis, select ‘flavomaculatus’. Press Enter.
Press enter again to move from subspecies to capture method. Type ‘By Hand’ then press
enter.
Now fill in the remaining fields as follows: Determiner:
J.C. Poynton;
Det. Year:
1997. Altitude: 150.
In the topography section, select the grey box next to gentle lower slope. A tick mark
appears. Continue according to the data that you wish to enter.
When you have finished, go back and check your form for any data that you might
have missed or that you have entered incorrectly. This is a very important part of
data entry and should be done for all forms.

Although the forms for each taxon are designed slightly differently, the procedure for data entry
is basically the same. Have a look through some of the other forms to get a feel for how they are
laid out.
All changes made in forms are automatically made in the tables and vice versa. Before entering a
set of data you should always check that the data is not already on the database. To do this for
e.g. the vegetation plots
a) Go to the database window and open the table ‘Trees > 10 cm dbh’.
b) Run a filter by form entering the FR Code and Plot number as the filtering criteria (see
2.6.iii).
c) If nothing appears when you run the filter, then you can proceed with the data entry by
returning to the EUCFP start-up form and selecting the data entry option etc.
Alternatively you can use the form filter tool (3.5.iii).
3.4
Using the find tool in forms
Using the find command is the simplest way to find specific information that you know is in a
database, and the Find button makes things even simpler. The command is available in both the
tables and forms. If, for example, you want to find the form for the reptile 14355, follow these
steps:
a) Open the reptile data output forms.
b) Click the mouse in the KMH number box of any record.
c) Select find from the Edit menu or click the ‘Find Record’ button at the top of the form.
d) Tick the box marked search only current field. The title bar of the new dialogue menu
should read ‘Find in field: KMH No.’
e) Type 14355 in the Find What edit box. Click on the ‘Find First’ button. Access displays
the form for the snake KMH 14355.
3.5
Sorting and filtering forms
3.5.i Sorting forms
You can use the sort command to arrange your forms in descending or ascending alphabetical or
numerical order. For example if we wanted to sort the amphibian forms by KMH number.
a) Click in the KMH edit box for any record.
b) Go to the sort command in the records menu and from the sub-menu select sort ascending.
Access sorts your forms into ascending order by KMH number.

15

East Usambara Biodiversity Database: A User’s Manual

3.5.ii Filtering forms
When dealing with large tables such as those in the Biodiversity Database, you can temporarily
focus on a subset of records that have something in common by using filters. For example if you
wanted to focus on all green mamba records you would follow these steps to apply a filter:
a) Open a reptile data output form. Go to ‘Filter’ in the Records menu. From the sub-menu
select ‘Filter by Form’. Access displays a blank form into which you can enter the criteria
by which you wish to filter the data.
b) In the Genus field type ‘Dendroaspis’ and in the species field type ‘angusticeps’.
c) Click the ‘Apply Filter’ button (a symbol of a funnel).
d) Access displays all records of Dendroaspis angusticeps (green mamba). The record
indicator shows how many records meet these criteria.
e) Use the record indicator at the bottom of the page to go through the records.
3.6
Printing forms
3.6.i Printing selected records
There may be times when you want to be able to refer to a form away from your computer. In
this case it is useful to print records. Follow these steps to print a particular record.
a) Place the cursor in the record that you would like to print.
b) Select Print Preview from the file menu.
c) Check that the data is laid out correctly. If you are not satisfied see 3.6.iii.
d) When you are happy with the layout of the form, close the print preview and go to Print
on the file menu.
e) In the print range section of the dialogue box select ‘print selected record’ to ensure that it
prints only the record that you are working with.
3.6.ii Printing blank forms
Sometimes you may want to print blank forms for use in the field. Blank forms are held in the
‘biodivf’ database. For example, if you wanted to print a new vegetation plot form.
a) Open the ‘biodivf’ database from the file menu.
b) In the database window go to the forms tab and select the Vegetation Plot 1 form.
c) Access opens a blank vegetation form. Before you print, you will want to check the
layout of the table so that you print in the most efficient way. Otherwise, you may find a
form spreading across several pages.
d) Use the page indicator in the bottom left corner of the Print Preview window to check that
all the information that you want is on a single page.
e) Once you are happy with the print layout go to the File menu and select print. In the Print
dialogue box select which pages you want to print and how many copies you need. Press
OK.
3.6.iii Changing page setup
If a form does not fit on a single page, you can adjust the layout of the page in a variety of ways.
For example:
a) Choose Page Setup from the File menu. The dialogue box which appears allows you to
adjust the setting on the Margins tab to manipulate the position of the data and how much
will print on one page.
b) Still in Page Setup, check that ‘Portrait’ is selected in the Page tab. If you were printing
something with many fields running horizontally you might want to print in ‘landscape’
view.
c) You should now be ready to print. Close the Page Setup and Print Preview and select
print from the file menu. Here you can select which pages you want to print and how
many copies.

16

East Usambara Biodiversity Database: A User’s Manual

3.6.iv Cancelling printing
There might be a time when you want to cancel a print job once you have started it.
a) If you want to cancel printing during a print job select the printer icon in the bottom right
hand corner of your screen. This displays a dialogue box.
b) In the dialogue box select the document that you want to cancel printing. In the document
menu of this dialogue box select cancel printing. Access informs you that it is cancelling
the printing.
3.7
Looking at form design
If you wish to change the design of a form you can do this in the form design view. Only the
database managers should make changes to the design of the forms. Before making such
changes, always make a back up of the database.
As mentioned earlier each field has a label and a control (3.2). The controls are usually to the
right of the labels. If you want to view the properties associated with a particular control:
a) Click on the control with the right hand button of your mouse.
b) From the shortcut menu that appears, click on ‘properties’ with the left hand button of
your mouse.
c) In the text box select the ‘all’ tab to view all the properties of your selected control.
These can be edited.
Some ‘forms’ are made up of a main form with one or more subforms e.g. the disturbance and
vegetation forms. The design of the subforms must be view separately from the main form. For
more information on changing the format of a form please refer to an Access manual.
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4)

Queries

4.1
Introducing queries
Queries are the most flexible way to search a database.
Access provides two types of queries: select queries can find and extract information from a
database, and action queries can update or delete records.
4.2
Select queries
Here are some examples of some select queries:
• The University of Dar es Salaam might want a list of all amphibians’ KMH numbers and
their identifications.
• A researcher might want a list of all the plots in which Cola usambarensis is found.
• A forester might want a list of all the Cephalosphaera usambarensis trees with a dbh
greater than 40 cm.
• The database manager might want a list of all the amphibian records with no genus and
species entered.
Access answers a select query by identifying the subset of records and fields that meet the
query’s criteria and placing the subset in a temporary table called a query datasheet.
If for example you wanted a list of amphibian KMH numbers and their identifications you would
do as follows:
a) Go to the database window of c:/biodiv/biodiv (see section 2.1 for an explanation).
b) When the list of tables appears, go to the ‘Insert’ menu and select query.
c) Access offers you five different options as to how to run your query. Select Simple Query
Wizard and then click OK. Access displays a new dialogue box.
d) Select Table: AMPHIBIANS from the Tables/Queries list to specify which table should
be used in the query.
e) You now need to select the fields that you wish to use in your query. For this example
click KMH No in the Available Fields list, and then click the > button to move it to the
Selected Fields box. Repeat this step for Genus, Species and Subspecies and click Next.
f) In the next dialogue box, leave the Detail option selected and click Next.
g) Assign Amphibian KMH No. as the query’s title and, with the Open The Query To View
Information option checked, click Finish. Access runs the query and displays the results
of the query.
h) Click the Close button to close the Query button.
The Queries list in the Database window now includes KMH List as an existing query. Any time
you want a list of amphibian KMH’s and their identifications, you can click the Queries icon on
the objects bar, select this query, and click Open. Access will run the query again and display a
new datasheet of results. If you have made changes to the AMPHIBIANS table, these changes
will be reflected in the new query datasheet.
4.3
Using criteria in select queries
4.3.i Using the query design view
The simple query wizard is most appropriate for queries that select entire fields from a table.
Access can also select fields from specific records only using the query design view. For
example suppose a researcher wants to know where all the Cephalosphaera usambarensis with a
dbh >40 cm are located.
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a)
b)
c)
d)
e)
f)
g)

h)

i)

j)
k)
l)

In the database window click on the ‘Queries’ tab.
In the queries window click on the new button to the right of the list of queries.
In the New Query dialogue box click on ‘Design View’.
You are now presented with the ‘Show Table’ dialogue box. This box displays all the
tables and queries in the database that can be used to run a query.
You need to select the table that holds the data that you wish to look at.
For the example described above you would select ‘Trees > 10 cm dbh’ and click Add.
Click Close to remove the show table dialogue box. Your query page is now divided into
two parts. In the top half of the window, a Trees > 10 cm dbh box lists the fields from the
Trees > 10 cm dbh table. (The* at the top of the list represents all the fields.) Below is a
table grid called the query by example (QBE) grid, in which you can visually construct
the query.
In the Trees > 10 cm dbh box, double-click the FR Code field to tell Access to include FR
Code in the results of your query. Access transfers the FR Code field to the first column
of the QBE grid’s Field row, identifies the field’s table in the Table row, and displays a
check mark in the box in the Show row to indicate that FR Code field values will appear
in the query datasheet.
Double-click TRSCT NO to transfer it to the second column of the QBE grid. Do the
same for PLOT ID and SPCMN NO. Then scroll the Trees > 10 cm dbh box and transfer
dbh, Genus and Species.
Now we need to specify that we only want trees from the genus Cephalosphaera with dbh
>40 cm.
Click the Criteria row of the dbh column and type >40. In the criteria row of the Genus
column, type Cephalosphaera and in the species column, usambarensis.
Click the run button (the red exclamation mark). You now have a list of all the
Cephalosphaera usambarensis trees with a dbh > 40 cm dbh.

If you change a record in the query datasheet, Access automatically changes the record in the
table.
When you type in text to be used as the criteria for a query, access automatically places quotation
marks around the text. If you decide to change your criteria, you must make sure that the
quotation marks are used correctly. Quotation marks should surround the text that you are using
as criteria but should not surround the logical or mathematical operators e.g. “Cola” or
“Diospyros”. If you do not use the quotation marks correctly an error message stating that ‘The
expression you have entered has an invalid string’ will be returned.
The simplest way to resolve problems with quotation marks is to remove them entirely each time
you change your select query.
4.3.ii Specifying dates in queries
If you want to use a date in a query you need to surround the date with pound signs (#). For
example if you wanted to select all records from July 1999 you could use the criteria:
>=#01/07/99# And <=#31/07/99#.
This rule only refers to those date fields where the format is dd/mm/yy. In most cases in the East
Usambara Biodiversity Database, each component of the data is entered in a separate field in
which case it can be treated in the same way as a normal number.
4.3.iii Deleting queries
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If you do not wish to keep a query, either do not chose to save it when you close or you can
delete it from the database window. To delete it simply select the query in the database window
and press delete. Access will prompt you ‘Do you want to delete the query ‘….’. Click Yes and
Access will delete the query.
4.4
Using Mathematical Operators
Access allows you to use mathematical operators in criteria, including = (equal to), < (less than),
> (greater than), <= (less than or equal to), and >= (greater than or equal to). These operators can
be used for such tasks as identifying trees within a certain dbh range as in the example of the
Cephalosphaera usambarensis.
4.5
Using Logical Operators
As you saw from the Cephalosphaera usambarensis example, you can narrow down the focus of
a query by specifying criteria in more than one field of the QBE grid. Sometimes you might want
to extract records that meet all of the specified criteria in all the fields (this And that), and
sometimes you might want to extract records that meet any of the criteria (this Or that). Let’s
look at a few examples.
4.5.i The And Operator
Where ‘And’ is used in a query, all criteria joined by ‘And’ must be met. Suppose you want only
the Newtonia buchananii trees with a dbh between 15 cm and 25 cm. You cannot simply state ‘>
15’ as the dbh criteria. Instead you must construct a range by using the And operator. Follow
these steps:
a) Open a new query in design view and select all fields from the Trees > 10 cm dbh. You
can do this by double clicking on the Title bar of the Trees > 10 cm dbh box. This selects
all the fields. You can then pick the fields up by left clicking within the selected area and,
keeping your finger down, drag the fields to the QBE grid and ‘drop’ them into the first
column.
b) In the Criteria row of the dbh type >=15 And <=25. In the Genus criteria row type
Newtonia and for species buchananii.
c) Run the query. The query shows only the Newtonia buchananii with dbh between 15 and
25 cm dbh.
4.5.ii The Or Operator
As you have seen, when you enter criteria in different columns but the same row of the QBE grid,
Access assumes that you want to extract records that meet all the criteria in all the fields. Now
suppose you have a researcher who wants to see a list of trees that are either Cola usambarensis
or Cola clavata. Follow these steps.
a) Start a new query in Design view selecting all the fields from the trees > 10 cm dbh table
(see 4.5.i for details of how to do this).
b) In the Criteria row of the genus field type Cola.
c) In the Criteria row of the species field type usambarensis Or clavata.
d) Run the query. Now the datasheet shows all Cola clavata and Cola usambarensis trees.
It is important to be clear of the difference between the Or and the And operators. Although
intuitively you have asked for both the Cola usambarensis and the Cola clavata records you must
remember that you are describing the criteria for the database to search by and not a list of the
records that you are interested in. In this example, if you had entered ‘And’ instead of ‘Or’, no
records would be returned as there are no Cola trees which would meet the criteria of being called
both usambarensis And clavata.
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4.5.iii The Not Operators
You use the Not operator to identify the records that do not meet a specified criterion. For
example, you can tell Access to identify all the small mammals that are not rodents.
a) Start a new query, this time select the MAMMALS table. Add the KMH No, Taxon Id,
Genus and species to the QBE Grid.
b) In the criteria row of the Taxon Id field, type Not rodent.
c) Run the query. The Datasheet shows only those mammals that are not listed as rodents.
4.5.iv The Null Operator
You use the Null operator to identify records that have no value in a specific field. If the
database manager wanted a list of records with no KMH number from the AMPHIBIANS table,
she / he could use the Null operator. For example:
a) Start a new query, this time select the Amphibians table. Add the KMH No. Genus and
species fields to the QBE Grid.
b) In the criteria row of the Genus field, type Is Null. In the species column go to the ‘or’
row and also type Is Null.
c) Run the query. The Datasheet shows all records for which there is either no genus or no
species.
4.6
Sorting with Queries
A basic feature of databases is the ability to sort data so that you can look at it in different ways.
We looked at using the Sort Ascending and Sort Descending buttons in tables. However to sort
on more than one column using this method, you have to rearrange the columns. Using a query,
you can sort the table based on any criteria. For example, suppose you want to list the trees
alphabetically by Forest Reserve and then by genus and species:
a) Start a new query using the trees > 10 cm dbh table. Add FR Code, Genus and Species to
the QBE grid.
b) Click the sort row of the FR Code column, click the arrow button and select Ascending.
c) Repeat Step b for the Genus and species field names.
d) Run the query.
If you want to use more than one field to sort the data e.g. genus and then species you need to
make sure that you place the fields in the QBE grid in the correct order. Access will work from
left to right i.e. it will sort all the data first by the field that is furthest left in the grid. It will then
move to the right for the next column by which to further sort the data and so on.
4.7
Updating records with queries
From time to time, you may want to change a value in several records in a table. For example
you realise that there is a new synonym for a tree species for example we might want to change
all Celtis wightii to their current name Celtis philippensis. You could update each record in turn,
but an easier way is to use an update query. Follow these steps:
a) With ‘trees > 10 cm dbh’ in the Tables list of the Database window, choose Query from
the New object button’s dropdown list. This button is usually to the right hand side of the
tools menu and has a drop down list arrow beside it.
b) Click OK to open a new query based on the ‘trees > 10 cm dbh’ table in design view.
c) Double-click the genus and species fields to add to the QBE grid.
d) Select Update Query from the Query Type button’s dropdown list. Access changes the
select query to an update query by adding an Update To row to the QBE grid.
e) In the Update To row of the species column type ‘philippensis’.
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f) In the Criteria row of the genus column type ‘Celtis’ and in the Criteria row of the species
column type ‘wightii’.
g) Click run. Access automatically changes all the Celtis wightii to Celtis philippensis. In
order to view the changes you need to toggle to the datasheet view either by using the
toggle button to the left of the tool bar or by selecting ‘datasheet view’ from the view
menu.
Be careful using this tool as you cannot undo it.
4.8
Simple calculations
Access provides a quick and easy way to perform calculations on field values in a query. Using
the Total row in the QBE grid, you can find the average, sum, highest value, lowest value,
standard deviations and the variance of the values.
Total row calculation options
The following functions are available for use in the Total row:
• Group by. Groups similar field values.
• Sum. Totals the values.
• Average. Calculates the average of the values.
• Min. Finds the lowest value.
• Max. Finds the highest value.
• Count. Counts all values in a field except nulls.
• St Dev. Calculates the standard deviations of the values.
• Var. Calculates the variance of the values.
• First. Finds the first record containing the value.
• Last. Finds the last record containing the value.
• Expression. Allows an expression (such as <15000) to be used as a criterion for a
calculation.
• Where. Allows criteria to be specified for a field that you aren’t using in the query
results.
Let’s say for example that we want to know how many specimens of each species of tree we have
recorded.
a) Create a new query based on the ‘trees > 10 cm dbh’ and move the genus, species and
specimen number to the QBE grid.
b) In order to specify that you want to make a query involving a calculation you need to
click the Totals Σ button on the toolbar. This changes the QBE grid and Access now
displays a Total row below the Table row.
c) Now you need to define how you want the data to be grouped and what calculations you
want to be performed. You will notice that the default value for all fields in the totals
row is ‘group by’. In this case we want to count how many trees have been recorded for
each species. We make the assumption that each tree that has been recorded has a
specimen number. Each specimen number therefore represents one tree. Click the
Total row in the Spcmn No column and then click the arrow button to display a dropdown list of calculation options.
d) From the drop-down list, select Count. The word Count replaces Group By in the Total
row. Access will now group the data first by genus and then by species and will then
count the specimen numbers occurring in each grouping (i.e. species).
e) Click on the run button. Access provides a list of the species with the number of times
that they have been recorded. You can sort this to find out the most common tree
species.
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If you wanted to find out the number of species for a single reserve e.g. Mtai do the following:
a) In the existing query, go to design view. Add FR Code to the QBE grid.
b) In the criteria row of the FR Code field type ‘MT’ to tell the database only to look at trees
found in Mtai.
c) Click on the run button. Access provides you with a list of the abundance of species
recorded in Mtai.
4.9
Multi-table queries
At times you might want to run a query using information from more than one table. For
example you might want to extract information from the table describing the ranges, habitat and
ecological associations of the tree species to use with the plot data. For example if you wanted to
view the range of the trees listed in the table ‘Trees > 10 cm dbh’, you could do the following.
a) Open a new query in design view. Select the trees > 10 cm dbh from the show table
dialogue box. Then select the ‘Tree Species Description’ table also from the show table
dialogue box.
b) Close the show table box. In the top half of the query page, both tables are displayed.
c) We now need to join the two tables. In order to do this the tables must have at least one
field that is the same. In this case ‘Genus’ and ‘Species’ are fields in both tables.
d) To join the genus fields select genus in the trees > 10 cm dbh box. Drag this over to the
genus field in the ‘Tree Species Description’ table and drop it.
e) A line appears linking the genus fields in the two tables. Repeat the procedure for the
species fields.
f) Now double-click the FR Code, Plot Id, Genus and species fields from the Trees > 10 cm
dbh table so that they appear in the QBE grid. Then double-click the ‘endemic status’
field from the Tree Species Description box so that it also appears in the grid.
g) Click run. The query datasheet lists all specimens with their endemic status.
You can use the criteria row in the same way as for other queries. For example if you are only
interested in Mtai you could type MT in the criteria row of the FR Code field. Similarly if you
only wanted Near Endemic trees you could type N as the criteria in the endemic status field.
If you are interested in endemic species be aware that endemics are divided into three categories
endemic to the East Usambaras ‘E (EU), endemic to the West Usambaras E (WU) and endemic to
both E (EU & WU). The syntax must be exactly the same in the query as it is in the table.
Alternatively you can use the Like command. By typing: Like “*E” in the endemic status field
of the QBE grid, Access will return all records which include “E”.
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5)

Database Management

5.1
Security
5.1.i Setting a password
A password can be used to restrict access to the database in order to avoid unauthorised changes
to the data. It is a simple way to improve the security of your database.
In order to set a password for the biodiv database proceed as follows:
a) With all databases closed, select Open database in the file menu.
b) Select the biodiv folder in c. With the list of databases held in biodiv visible, click on the
box marked ‘exclusive’ beneath the Advanced button on the right hand side of the
dialogue box.
c) Now select the biodiv database and click the Open button. Access opens the biodiv
database only (i.e. without opening the linked database biodata which would normally
open automatically on opening biodiv).
d) With the biodiv database open select Set Database Password from the security option in
the tools menu.
e) Under ‘password’ in the new dialogue box, type in your chosen password. Now type it in
again under ‘verify’. Click OK.
f) Your database is now protected by a password. You will need to enter this whenever you
open ‘biodiv’. Write the password down in a secure place. If you forget this password,
you will no longer be able to access your database.
Remember that passwords are case sensitive. It is best to have your password entirely in lower
case. If Access is denying entry, check whether Caps Lock is selected.
To remove the password follow the same steps as described above except that under security in
the tools menu you should select Unset Database Password. In order to unset the password you
need to know the existing password.
If you chose to unset the password you can either remove the password entirely or you can set a
new password.
5.1.ii Changing a password
To change a password you need first to unset the existing password and then set a new one.
Follow these steps:
g) Open the database with the exclusive option selected (see 5.1.i).
h) In the Security option in the Tools menu select Unset Database Password.
d) You will be prompted to enter the current password. Enter the current password and click
OK.
a) You now need to set a new password by following the steps described in 5.1.i.
When you put the EUBD onto the computer in the computer room remember to unset the
password as this version should not be password protected.
5.2
Backing up the database
The computer in the library holds the master copy of the EUBD. It is essential that backups be
made regularly so that work is well protected. Backups protect you from losing all your work in
case something happens to the master copy of the database. For example a virus could wipe all
the files from your computer, the hard drive on your computer could fail, someone could
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inadvertently delete the database, the computer could be stolen or damaged by fire. All of these
things happen and so it is essential to make back ups. Back up copies should be held:
i)
On zip disk: while data is being entered, the database should be saved onto a zip disk
at the end of each day.
ii)
In the computer room: this should be updated at least once per month.
iii)
In the CTA’s office: this should be updated at least once per month.
iv)
At the University of Dar es Salaam: this should be updated at least once every six
months. Arrange with the Frontier staff to bring a zip disk so that they can take a
copy of the database to Dar es Salaam.
5.3
Viruses
Viruses can wipe out your database. Run the virus checker regularly remembering to select the
‘all files’ scan option.
Get into the habit of running the virus checker first thing every morning. Anyone putting a zip
disk or floppy disk into the computer must clean the diskette first.
Viruses are frequently transferred in e-mail attachments. If you are surprised at receiving an
attachment from a sender, do not open it but check with the sender whether it is genuinely from
them. Do not open attachments on the library computer. Ideally it is best not to run the Internet
from a computer holding the master copy of important databases.
Make regular back-ups of the database.
5.4
Quality control
5.4.i Avoiding errors in data entry
The quality of the database depends on the quality of the data entered. It is essential that people
entering data check their work carefully and that the managers of the database also check the data
at regular intervals.
a) When you finish entering the data from a form, always go back and check that each
section has been entered correctly. In the case of the vegetation data, take particular care
that the dbh values correspond with the genus and species.
b) Always use the default spelling of taxonomic names available from the drop down lists in
the forms.
5.4.ii Checking data quality
At regular intervals check the tables. There are three key things to look out for
1) Duplicate entries
2) Incorrect entries
3) Incomplete entries
5.4.iii Duplicate entries
The easiest way to check for duplicate entries in the vertebrate tables e.g. AMPHIBIANS is to
check whether a KMH number has been entered more than once. To do this you can count the
number of times each KMH number has been entered. You can then quickly sort the records in
descending order to see whether Access has counted any KMH number more than once. To do
this, follow these steps:
a) In the Amphibians table check that the KMH number and FR Code are available for all
entries. The quickest way to do this is to sort the data in ascending order by KMH
number. Any blank KMH number entries will be listed first. If there are blank entries
that can be traced by looking at the original forms, then this should be done.
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b) Using the FR Code field, sort the data in ascending order. Again, if there are any blank
entries try to trace these using the hard copies of the data.
c) Close the Amphibians table.
d) Open a new query in design view selecting the KMH Number and FR Code fields from
the Amphibians table.
e) Set up a totals query by clicking on the Σ button on the tools bar. Grouping the data by
KMH number, select ‘count’ in the FR Code field and click the run (the red ‘!’) button.
Access now counts how many entries have been made for each KMH number.
f) Sort the results in descending order by FR Code. If a specimen has been entered on more
than one occasion there will be a number >1 beside the relevant KMH number. Make a
note of any duplicate numbers.
g) If there are duplicate KMH numbers return to the Amphibians table and run a filter by
form entering the relevant KMH number as the filtering criterion (see section 2.6.iii). If
necessary try to trace the data back to the original forms.
To check for duplicate entries in the trees > 10 cm dbh tables you will apply the same principle as
that used to check for duplicate entries in the vertebrates table. However in the case of the trees
you will be grouping the records by FR Code, Plot Id and Spcmn No and counting the entries in
the genus field.
a) In order to run this check, all specimens must have their FR Code, Plot ID, Spcmn No.
and genus listed. In the trees > 10 cm dbh table check that there are entries for all FR
Code, Plot ID, Spcmn No. and genus field values by sorting the data in ascending order
by these fields (see above).
b) Open a query in design view selecting the FR Code, Plot number, Spcmn No. and genus
fields from the trees >10 cm dbh table.
c) Set up a totals query by clicking on the Σ button on the tools bar. Grouping the data by
FR Code, Plot ID and Spcmn No, select count in the totals row of the genus field. And
click the run (red ‘!’) button.
d) Sort the results in descending order by genus. If a tree has been entered more than once
there will be a number >1 in the genus field. Make a note of any plots with duplicate
entries.
e) If there are duplicate entries return to the trees >10 cm dbh table and run a filter by form
to select the offending plots. Now check the original forms and correct the data
accordingly. (See 2.5.ii on deleting records).
5.4.iv Incomplete entries
For some records data may not have been entered in all fields. The quickest way to check for this
is to sort each field in ascending order. Any blank entries will be listed at the top of the table.
5.4.v Incorrect entries
This is the most difficult type of error to identify. To avoid incorrect entries it is essential to
check data carefully at the time of entry.
Spelling mistakes in the trees > 10 cm dbh table can be checked in the following way.
a) Set up a query in design view based on the table trees > 10 cm dbh.
b) Select the genus, species and Spcmn no fields.
c) Add in a total row by clicking on the totals Σ button on the tool bar. Keep the default
group by option in the Genus and species column.
d) In the Spcmn No. field select count from the totals row drop down menu.
e) Click on the run (the red ‘!’) button.
f) Sort the results in ascending order by genus and species.
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g) Read down through the taxonomic names to check whether there are any similar entries
that could be alternative spellings of the same name. If you do find spelling mistakes, you
can either change them in the query or you can return to the table and change them there.
If you find numerous spelling mistakes in a particular plot, go back and check all the data for that
plot as a few spelling mistakes may indicate that the plot was not carefully checked at the time
that it was entered.
As additional species are recorded by the biodiversity surveys you should add these to the drop
down lists used in the data entry forms to minimise spelling mistakes. You can do this by typing
in the additional species to the table used for the drop down list e.g. to add a tree species go to the
TREES species table. To find out which table to use for the drop down lists for other taxa, see
Appendix 1.
Numerical records can be scanned for anomalously high or low values by sorting the data and
checking the highest and lowest values to see whether these are realistic. For the vertebrates you
can also check the length data against the weight for example a snake 1m long is going to weigh
more than 10 g!
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Appendix 1

A breakdown of the contents of the database tables

Table
Amphibian species
range and habitat
description

Location
C:Biodiv/Biodiv

AMPHIBIANS
Amphibians species

C:Biodiv/Biodata
C:Biodiv/Biodiv

BATS
Bat species

C:Biodiv/Biodiv

BIRDS
Bird species

C:Biodiv/Biodata
C:Biodiv/Biodiv

BUTTERFLIES

C:Biodiv/Biodata

Butterflies species

C:Biodiv/Biodiv

Butterflies table

C:Biodiv/Biodata

DISTURBANCE
SURVEY

C:Biodiv/Biodata

Disturbance survey
table
Disturbance survey
table1

C:Biodiv/Biodata

Forest Reserve
Descriptions

C:Biodiv/Biodiv

MAMMAL DUNG
SURVEY

C:Biodiv/Biodata

Mammal dung survey
table

C:Biodiv/Biodata

C:Biodiv/Biodata

Description
The endemic status, habitat association, IUCN
listing and CITES category of many Usambara
amphibians. This table can be used in multi-table
queries to extract records on e.g. the distribution
of endemic amphibians.
Amphibian records from the EUBS.
A list of most amphibians likely to be recorded in
the EU. This list is used as the basis for the ‘click
lists’ on the forms.
Bat records from the EUBS.
A list of most bats likely to be recorded in the EU.
This list is used as the basis for the ‘click lists’ on
the forms.
Bird records from the EUBS.
A list of most birds likely to be recorded in the
EU. This list is used as the basis for the ‘click
lists’ on the forms.
Locality and habitat information arranged by trap
for butterfly records made by the EUBS. This
does not include the species identifications. There
is a link based on the FR Code and Plot ID
between this table and the ‘Butterflies table’ (see
below).
A list of most butterflies likely to be recorded in
the EU. This list is used as the basis for the ‘click
lists’ on the forms.
Butterfly species records from the EUBS. This
table is linked to the ‘BUTTERFLIES’ table by
the FR Code and Plot ID.
A list of transects and Forest Reserves surveyed
by EUBS. This table is used to link the
disturbance survey table with the disturbance
survey table1.
Records of cut and live trees and saplings arranged
by plot section.
Summary of disturbance organised by plot. This
table stores data entered in the left hand side of the
disturbance form.
A description of the area, elevation, gazettement
history of the forest reserves of the East
Usambaras including a key to the forest reserve
codes used in other tables.
A list of transects and Forest Reserves surveyed
by the EUBS for mammal dung. This table is
used by the mammal dung form and is linked to
the Mammal dung survey table.
Mammal dung records from the EUBS.
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Table
MAMMALS
Mammals species

Location
C:Biodiv/Biodata
C:Biodiv/Biodiv

MILLIPEDES

C:Biodiv/Biodata

Millipede species

C:Biodiv/Biodiv

Millipedes table

C:Biodiv/Biodata

MOLLUSCS

C:Biodiv/Biodata

Molluscs table

C:Biodiv/Biodata

REGENERATION
PLOT
Reptile species
ecological and range
descriptions

C:Biodiv/Biodata

REPTILES
Reptile species

C:Biodiv/Biodata
C:Biodiv/Biodiv

Tree species range and
habitat descriptions

C:Biodiv/Biodiv

trees < 10 cm dbh
trees > 10 cm dbh
TREES of the East
Usambaras
TREES Species

C:Biodiv/Biodata
C:Biodiv/Biodata
C:Biodiv/Biodiv

TREES Species
(Rodgers &
Homewood)
Vegetation Plot

C:Biodiv/Biodiv

C:Biodiv/Biodiv

C:Biodiv/Biodiv

C:Biodiv/Biodata

Description
Mammal records from the EUBS.
A list of most mammal species likely to be
recorded in the EU. This list is used as the basis
for the ‘click lists’ on the forms.
Locality, habitat and total number of specimens
information from EUBS records.
A list of many millipede species likely to be
recorded in the EU. This list is used as the basis
for the ‘click lists’ on the forms.
Millipede species records from the EUBS. This
table is linked to the ‘MILLIPEDES’ table by the
FR Code and Plot ID.
Locality, habitat and total number of specimens
information from EUBS records.
Mollusc species records from the EUBS. This
table is linked to the ‘MOLLUSCS’ table by the
FR Code and Plot ID.
Locality and habitat data for the regeneration
plots. This table is linked to trees < 10 cm dbh.
The endemic status, habitat association, IUCN
listing and CITES category of many Usambara
reptile species. This table can be used in multitable queries to extract records on e.g. the
distribution of endemic reptiles.
Reptile records from the EUBS.
A list of most reptile species likely to be recorded
in the EU. This list is used as the basis for the
‘click lists’ on the forms.
The endemic status, habitat association and
ecological type of many Usambara tree species.
This table can be used in multi-table queries to
extract records on e.g. the distribution of endemic
trees.
Plant species records from the regeneration plots.
Tree species records from the vegetation plots.
A list of Usambara trees with families and authors
A list of many tree species likely to be recorded in
the EU. This list is used as the basis for the ‘click
lists’ on the forms.
Trees listed by Rodgers and Homewood in their
1989 paper on endemism in the East Usmabaras.
Locality and habitat data for vegetation plots.
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Database window, 6
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form design, 17
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Excel, 4, 9
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Field value, 7
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Filters, 9, 16
auto filters, 9
filter by form, 9, 16
removing filters, 9
Find and replace tool, 8, 15
Forest reserve codes, 3
Forest Reserve maps, 4
Forms, 4, 14
Incomplete entries, 26
Incorrect entries, 26
Logical operators, 20
and, 20
not, 21
null, 21

or, 20
Mathematical operators, 20
Microsoft Access, 3, 4
Office assistant, 5
Opening the database, 6
Orientation Programme, 3
Password, 24
Printing forms, 16
QBE grid, 19
Queries, 4, 18
deleting queries, 19
multi-table queries, 23
sorting in queries, 21
update queries, 21
Record, 8
Record indicator, 7
Saving changes in tables, 11
Scrolling, 7
Sorting records, 9
Spelling mistakes, 26
Start up form, 6
Sum, 22
Tables, 4, 6
Editing field values, 8
Total row, 22
Variance, 22
Viruses, 25
Windows
sizing windows, 10
Word, 4

30

